INTRODUCTION TO EXCEL 2003
(partially taken from "User's Guide to Microsoftdex’)

Welcome to Excel! This reading will walk you thgiua simple physics example and how you can usel Exc

to do data analysis more efficiently and easilhisBection will be a valuable reference as yothgaugh the
semester doing your analyses.

Starting Microsoft Excel

If there is no desktop icon to open Excel, cliok $tartbutton and open th&ll Programsmenu. Excel will
show up as a separate icon or will be found ilMieosoft Office folder.

Opening a Workbook

The workbookis the normal document or file type in Microsofkcél. A workbook is the electronic
equivalent of a three-ring binder. Inside work®gku'll find sheetssuch as worksheets and chart sheets.
Each sheet's name appears on a tab at the bottthra wiorkbook. You can move or copy sheets between
workbooks, and you can rearrange sheets withinrkbook.

In this tour, you'll make a new workbook in whigbu will be calculating the velocity and its uneanty
from a set of data values for distance and time.

What's on the Screen

When you create or open a workbook, Microsoft Edigplays it in avindow There are a few areas
of the Excel window which you should note.
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Most of the work you do in Microsoft Excel will ben aworksheet A worksheet is a grid of rows and
columns. Eacleell is the intersection of a row and a column andaasique address, oeference For

example, the cell where column B and row 5 intérsecell B5. You use cell references when youewri
formulas or refer to cells.

Generally, you firstselectthe cell or cells you want to work with, and thgou enter data or choose a
command. Selected cells appear highlighted on gotgen. Thective cellis the cell in which data is
entered when you start typing. Only one cell tivacat a time. The active cell is shown by a lydasrder.

In the preceding illustration, cell Al is the aetisell.

»To change the active cell

Move the mouse pointer into cell B4 and click ldgfemouse button.
Notice that the cell's reference ("B4") and itkiegblank so far) appear in the formula bar.



»To scroll through the worksheet

1. Move the pointer to the down arrow in the vaiticroll bar on the right edge of the window, &émeh
click.
The worksheet scrolls down one row.

2. Click the scroll bar area below the scroll box.
The worksheet scrolls down one screen.

3. Move the pointer into the scroll box. Hold te#t mouse button down, move the pointer back ¢otdip
of the vertical scroll bar, and then release thesadutton. This is called dragging.
The worksheet scrolls back up to the first row.

Entering and Editing Data

Imagine wanting to find the velocity of a car. Frbasic physics, you know that the velocity isteglao the
distance and time traveled in the following ways(emsing constant v):

d . o .
V= T wherev is the velocityd is distance antlis time.

So, a simple experiment would be for the experigrefyu!) to use a stop watch to test the amoutiiraf it
takes the car a known distance and from this, lzdcthe velocity using the above equation. Lieyshis.

First, we need to enter the data. Let's have tbokemns: distance, time and velocity. It's usédugive each
column a heading. Select cell Al and typiee (s). This simply indicates that the column of datdofeing
cell A1 will be of times measured in seconds. Galell B1 and typeDistance (m)and presENTER Since
the entire word does not fit into the cell, youlwied to adjust the column width. Move the poibitween
the B and C column headings until it changes intowable arrow, and then double click (always useléft
mouse button). Finally, select cell C1 and entefocity (m/s). Go back and select cell A1l. Notice in the
formula bar appears “Time (s)”. If you wanted kaoge the heading, you could click the mouse cunsan
the formula bar and retype.

You should periodically save your worksheet. dtiytj go into the File menu, choose SaveAs. Gdpera
Excel files are given the extension .xlIs (e.gxl. To save the file on your floppy disk (ifstriot
already), click on the down arrow und@rives and select:. A suggested file name will appear
under File Name: To change it, click on the Filanhe: box and edit it as desired\s you proceed,
occasionally save your worksheet by typing CTRL-S.

Now we can enter our data. Let's assume thantbasurement was performed three times at thresratitf
distances of 500m, 1000m, 250m, and the times foere to be 20s, 42s, 9sspectively. Highlight cells
A2:B4 (A2 through B4). Enter 20, 42, 9 (no unitskells A2, A3, and A4 respectively. Similarlytenthe

corresponding distances in the B column. Your wloget should now resemble the following illustratio

A | B | € |
_1 [Time (s) Distance (m) “elocity (mfs)
ra 20 5IIIIII| _l
3 42 1000
4 | 240
5 |

Building Formulas to Calculate Values



So far, you've entered data in a worksheet. Tiyrewke that data useful, you'll write formulaBormulas
can do simple things, such as adding the valugwdncells, or they can do much more complex things.
Here's how Excel uses the SUM function to add talaes together.

On paper, you might A |
1 &~ add two numbers like 1|1
42 this 22
3 "7 3 |=3UM(A1:A2)
4

You can always identify a formula in Excel becaitsgtarts with an equal sign (=). You normally see

formula itself only when you're editing the celhticontains the formula. Otherwise, you see thHaeva

produced by the formula. In Excel, do this

Now you will create a formula to calculate the i

1. If it's not already selected, choose cell C2.

2. Type=B2/A2. This tells Excel to use the value in cell B2 (580) divide it by the value in cell A2
(20). Hit ENTER. The value 25 should appear ea¢bll. Click back onto cell C2. Notice that
the formula =B2/A2 appears in the formula bamd€essary, you could click up there to edit it.

3. Instead of having to rewrite the same formatecklls C3:C4, you'll want to use the “fill hantlle

Position the mouse cursor in the lower right coikeown as the fill handle) of cell C2 until it
resembles a plus sign.

Selected cel Yelocity (mds
EE.EI_

Click on the fill handle of cell C2 and drag theume down through cell C4. The formula should
automatically increment such that in cell C4, thariula should read =B4/A4, while the value
should be 27.777...

Fill handle

Say you wished to find the average of all the veéx: Instead of typing =(C2+C3+C4)/3, Excel lzas
function which will do this automatically.

1. Select cell C5.

2. Type=in the function bar, then click on tte button just at the left of the formula bar. Stlec
AVERAGE if it appears as a function selection in the eurreenu or delect thstatisticalcategory of
functions and click oAVERAGE. Note the parenthesis and don’t hit ENTER yet! bould be
prompted to enter the range of cells to be averalyete: when you become familiar with the different
functions available in Excel and the proper forfmatentering function arguments, you can type them
directly into the cell (after the = sign).

3. TypeC2:C4 NOTE: You may also use the mouse to highlight these.cells

4. Close the parenthesis with the final result dgpeirAVERAGE(C2:C4)

5. Pres&ENTERto accept the proposed formula. The final vahaul be 25.529...

As is, your final value could have any number gfitdi When you learn more about significant figuingou
will know how many digits it should have. For noet's assume we only want to go to the tenthseplac
With the mouse, highlight cells C2:C5. The fahtign the toolbar should include Increase/DecrBaesémal

buttons which look like this. If they are present, click on them to decrehsevalues to only have
digits in the tenths place. You may also needdjosh the column width. If the Increase/Decreaseimal
buttons are not present, your toolbar has beemtpoesustomized not to include the buttons. Yan add
them by customizing your toolbar, but for now y@u @lso change the number of decimal places cfjakin



Formatin the menu bar, then selétimberfrom the Number Tab. You will be prompted for thenber of
decimal places you want.

Whenever you have a new value, you should alwassiga label. In cell B5, typaverage =.

You worksheet should now appear like the following:

A | B | C |
_1 |Time () Distance (m) “elocity (m/s)
2| 500 250
3 42 1000 238
1 g 250 2754 =B4A4
L aerage= [ 28 8le—avERAGE(C2:CH)

Select any blank cell and hit the fx (function)tdmutfrom the toolbar to discover what other fornzula
Excel offers. You might want to try other formudasl see how they all work. Choose a formulactele
the range from the data given, end the parentlasishit ENTER. Be careful not to change any vailues
your range! Before proceeding, be sure to delatereew formulas you've created.

Standard Deviation

This average value is perfectly reasonable, but thewou account for it only being the average? bést
way to do this is to use the property of standandadion which gives an indication of the spreadedbcities
used in calculating this average. As an analdggktof it as throwing darts at a dart board. hihgs are
going well, most of the darts will hit a small are@ar the bulls-eye resulting in a small standandation.
However, if it's a bad day and the darts are gaithgver the place, then there is a large standaviation.

. : 1 &, o o
The formula used to calculate standard deviatibrengasao, is: 0:\/N1 ZI><|)—)(]2 This is a pretty
L ia
involved expression, but fortunately, Excel hasiacfion which will work through it automaticallyThis
function is=STDEVP(range whererangeis the set of data for which you wish to calculateStandard
deviation only works for a large number, N, of daténts; as a general rule, you should have at Iéadata

points to use standard deviatiohe uncertainty in the average is not mmstather, it is%. Select cell
C6, type= and using the function,jfin the tool bar or the function menu in the fotabar select the
command for standard deviation (but don't press ERet). The range, for this case, will®2:C4, which
you can type in manually or select by highlightthgse cells. To divide byN, enter/SQRT(3), since you
have 3 data points. The end formula should®€DEVP(C2:C4)/SQRT(3) The value you should get is
0.960...m/s. Decrease the decimals down t-dr more explanation on standard deviation, rehd tast
section of theExperimental Uncertainty Review link on the Physics 108 web page and theertainty
Tutorial link on the Physics 108 web pagé&dbel this by typindJncertainty = in cell B6.

»Before we proceed to the next section, you'll nieedio a few things first.

1. Select cells A2:C2.

2. Choose COPY from the Edit menu. A dotted lineudd appear around the cells.

3. Click on cell A8.

4. Choose PASTE from the Edit menu. Cells A8:C8usthnow be a duplicate of A2:C2.



Partial Uncertainty

The above calculations assumed that every data v&lexact. There is an uncertainty associatdu egth
measurement which will give an uncertainty for ¢agculated velocity. This uncertainty will tellethperson
reading your data (us!) about what the velocitypig, makes no claims that this is exactly whatvédecity is
(because it's not). To get an uncertainty, you maled to make an educated guess (how these gusses
made will be explained in lab) as to how far oftiymneasurements might be. For example, supposgdha
measure the time traveled to have been 20 sec.y&utreaction time may have slowed you down, aylne

it was a little hard to tell when the car exactipssed the border (how well do you know the distanc
anyway?), so maybe the time could have been angwigween (17-23)sec. In that case, (20+ 3)sec

Since no measuring device is completely accuratedistance has some uncertainty to it as wellt'sLe
say d =(500+ ) m. To find the uncertainty in the velocity, we Miise partial uncertainties. This

means that we will find the partial uncertaintytioé velocity with respect to the 1) distance andirag
and then sum of the partials gives the total uagsst.

Let's do the distance first. We assume there’stime uncertainty and see how just the distance
uncertainty affects our calculation of the velocity

1. Highlight cells A8:C8.

2. Using the fill handle, drag down through cell2AC12. Now you should have five identical rows of
data.

3. Choose cell B9. In here, you will enter the ndéstance 0601 (=500+1). Notice cell C9. The
corresponding velocity should have automaticalgngjed to 25.1(isn’'t Excel great?!)

4. Enter the min distance (=500-1) into cell B10.

5. Enter the min and max times in cells A11 an@ Adspectively.

This section of your worksheet should resemblddt@wing:

A | B | C |
7]
&) 0 500 260
a2, 4 ot 251 >Sdifff2=unc in v wrt d
L 429 260
11 17 500 29.4 _ _
12 23 00 517 >diffi2=unc in v wrt t

Now, if you find the difference of cells C9:C10 digd by two, this will give the partial uncertainby
velocity with respect to (wrt) the distance. Tlaetial forv wrt t is from the diff/2 of cells C11:C12. To find
the total uncertainty of the velocity, add togetthese two partial uncertainties. Find this valsimg Excel.
To find the partial with respect th select cell C13 and enter the forma{€9-C10)/2 Move to cell C14 and
do similarly for the partial with respect to timginally, select cell C15 and add together cell8€114. This
value is the total uncertainty for the velocityt. isl also very helpful to label each of these uiaiaties for
what they are. For example, in cell A13, you cayfie: partial unc wrtd =

For more on partial uncertainties, see tExperimental Uncertainty Review and Uncertainty
Tutorial links on the Physics 108 web page.
Creating a Chart
Chartsare visual representations of worksheet data.eliErcludes several chart types, such as bar,dime,

pie charts. You can use charts to clarify trendeelationships that might not be apparent in tiogkgheet
data alone.



A chart is either embedded directly on a worksheeff appears on its own chart sheet in the waskbo
Excel automatically updates a chart if the workstbaea upon which it's based changes.

Now you'll create a line chart of the distancetivse data and embed it directly on the workshé&et.do this,
you'll use theChartWizard and interactive charting assistant.

1. Highlight the cells in the worksheet that yountv@ be graphed.
|

2. Click the ChartWizard buttorg

The ChartWizard dialog box appears.

Select X-Y scatter.

Select the graph subtype from the samples bigt gata points but doesn’t draw lines or curves.

Choose thélextbutton to continue.

That data range you selected in step 1 shouttispéayed as the current setting. If it is narect

or you want to change it, make the changes indkerdnge box.

Choose thélextbutton to continue.

8. Add a chart title and x and y axis labels. gsdilfferent tabs in this window, you can also atljus
the axes, add gridlines and a legend for data goiRbr this graph, click on the legend tab and
deselect th&how Legenbdox.

9. Choose thalextbutton to continue.

10. You now have the choice to place the charthercurrent worksheet or to place it on a new sheet.
Select the appropriate button to place the chaybon current worksheet.

11. SelecFinish.

o0k w

Excel creates the chart on the worksheet.

Manipulating the Chart

Often, we will ask you to find the slope of the tiédine for your data. Excel will calculateriumerically as
well as draw this line (called a “trendline”) oretbhart.

1. Select cell B17. Typeest slope =

2. Move to cell C17. Entevlinest(B2:B4, A2:A4) Where B2:B4 are the y data, and A2:A4 are the x.

3. Hit enter, and the value for the best-fit slgpkich is the velocity--do you see why?) of 22.5m/
should appear.

To plot this best fit line

1. Single click on your chart (it will become oo in color).

2. Click on one of the data points (they shouldegpmighlighted).

3. Under theChartmenu in the toolbar, choo$eendline..

4. A new window should appear with two options.deinType, choose the linear graph option..

5. Hit OK and the best-fit line should appear oarygraph. To display the equation on your graph,
double click on the best fit line on your graphnddr theOptionstab, selecDisplay Equation on
Chartand hitOK. Notice the slope calculated above correspontigettinear term of your
trendline equation. Make your own calculationhi$ slope and see how it compares to Excels.

6. To make the line thinner, double click on time litself. AFormat Trendlinevindow should appear.
You can change the weight of the line by gointh&Patternstab.



(Note: This is only the best slope. We will askiyo do max and min slopes as well. Excel will Ndorthis
for you. Can you figure them out? For hints, gtheExperimental Uncertainty Review link on the Physics
108 web page to the section on Graphs and Errgsfldncertainty in the Slope of a Line.)

Occasionally, you may need to change the scaledaixes. The same technique applies to eitherdhg
axes. In this example, you will change the y.

1. If the chart isn't still selected from beforeutble click on it.

2. Double click on the y axes. Format Axesvindow should appear.

3. UnderScaletab, first unclick the Auto box next to Minum: and change its value-t00Q
4. ChooséK, or hitENTER and the scale of the y axes should have changed.

Printing your results

The information in this section should apply to R¥Elab you do, so make careful note of its contents
When you're happy with how your worksheet looks @isdready to be printed, save it to your floppyda
move to one of the printer-connected computersvagsé try to make sure it will print how you wantlie
FIRST time. In general, we try to make the analgsizh that it will take only one sheet of paper.

To see how the printed copy will appear, seltnt Previewfrom theFile menu. (Do NOT select the
printer icon!) At the bottom of the Print Previgwage, it will indicate how many pages long the
document will be. If it will take many pages, tige of the following "tricks" to minimize pages:

A. Have the document print horizontally ratherrtheertically: Click on theSetupbutton and
then choose the Page tab, if it's not already sedec Select.andscapéefor the Orientation
and click onOK.

B. Change the scaling: Again, click on tBetupbutton, Page tab. Under Scaling, eitheljust
to: X% of normal size, or click onitho: 1 page wide, by 1 tall.

Close thePrint Previewoption. If you scroll around on your worksheebuyshould notice two dotted
lines: vertical near column J, and horizontal mear 40. These lines indicate page breaks. Try¢ognt
words from spilling out onto the next page by atipgscolumn widths.

Finally, once everything will fit on a (hopefullysingle page, go back ®age Setup. (you can get there
directly under therile menu). Select the teéBheet In the middle section, Print, click the box néoxt
Row and Column Headingsuch that a smal appears. Please do this every time you printaelE
worksheet. On the right side of this window, clitle Print... button. A print dialog box will appear;
check to make sure that the printer is on and m@-dind then click o®K. Compare your finished page
with the final product below.



A | B p | E | F | 6 |

_1 [Time (g) Distance {m) “elocity (m/s)
2 20 500 250 velocity (m/s)
3 | 42 1000 238
4 g 250 278 1500
8| average= 26
6 | uncerainty= 1 1oo0 4

7
8 | 20 500 250 E sl
9 20 501 251 z
M| 0 459 25.0 E 0

11 17 500 29.4 = ' ' ' '
2 = 500 217 vow W
E parial unc wrt d = 0.1 -0y
4 |partial unc wirt t = 3.8
15 |total unc = 4 -1000
16 | time (s)
7 hest slope= 227

18

After printing your worksheet, write the formulased in Excel on the sheet itself or in your lakehobk..

Spend the rest of the time simply messing arourti Excel.
straightforward to use, and it definitely has itsrks! But, if you learn it, it will sava lot of time for doing

It's a powerful spreadsheet and fairly

analysis.
Have fun!
USEFUL EXCEL FORMULAS
in English in Excel

plus minus times divided by power of + - A
average =average(nge
standard deviation =stdevp(ge
T =pi()
square root =sqrutell)
exponent (e.g. 3x1Y) E (e.g. 3E-3)
[arc]cosine oB (6 in radians) =[a]coscell)

[arc]cosine 0B (8 in degrees)

=[a]cos((PI()/180)*¢ell))

slope from maAy/Ax

=linestfy range x rangeg




